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L e s s o n  1

Project Setup

Overview

In this lesson, you will connect to a Prolog Manager database, set up 

companies in a database, import information from other Prolog Manager 

files, and set up cost periods.

It contains the following tasks:

PROJECT SETUP

A. Connecting to Prolog Manager

B. Setting Up Other Companies on a Project

C. Importing Data from Other Sources

D. Setting Up Cost Periods
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A. Connect ing t o Prolog M anager
Prolog Manager 6 data resides in a database. A Prolog Manager 6 database can contain data for one or more 

projects. In order to work with Prolog Manager data, you must first log on to a database on your computer or 

on another computer to which you are connected, and then you must select the project whose data you wish 

to work with. However, you can also create new projects within a database. In this task you will log on to 

Prolog Manager and open database called prolog sample database. You will create a new project within that 

database and then enter data for that new project. 

A.1 How Do I Log On to Prolog M anager 6?

In this section, you log on to Prolog Manager and the Prolog Sample Database. You will open an existing 

project in the database but do no work in that project.

On the Prolog 

Manager 6 File menu, 

click Open Database

Connection Name: 

select prolog sample 

database

User Name list: select 

Admin

Click OK

Select  Project: select 

East Valley Hospital

Click OK:

Prolog Manager 

appears
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A Cool Tool: Your projects are arranged into groups Close-out , Construction and Pre-

construct ion; these groups are determined by the selection in the Project Status 

field. You can change the field by which projects are grouped. For example, you 

could use the owner or the project manager as the field which determines the 

grouping arrangement. To change the manner in which projects are assigned to a 

group, on the Portfolio M anager, click Set Groups.

If Admin does not appear in the User Name list, click Refresh:

Leave the Password field blank for now. Generally, a password is required.

Admin is a “pre installed user” with maximum permission to change your setup. Later you 

will log in as yourself.

The projects in this database are grouped into Close-out , Construction and Pre-

construction phases.

You will open East Valley Hospital for this project and then create a new project from 

within the database. However, you could click Create Project  to skip directly to step 3 of 

the following section.
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A.2 How Do I Create a New Project?

All information in Prolog Manager is organized by projects. Projects reside in databases. The prolog sample 

database contains a project with which you will do most of your work in this book. However, in this task you 

will create a new project. 

You are able to create a new project because you are logged on as Admin. A user logged in as Admin has the 

widest possible permission to perform tasks within the system.

In this task you will not enter all of the information about the project you might normally enter but only the 

essential information .

  1. Create the Project

Prolog Manager File 

menu: click Portfolio 

M anager

Click Add

Click OK.

The Portfolio 

M anager window 

displays a new 

project titled Prolog 

M anager New Project 

in a group titled 
<Property Not Set>.

A message asks which Project  Template you wish to use. Default is already checked. 
The project template can include project specific data, such as lookup list 
information. However, the default template is empty of such material. You can 
create additional templates with Prolog Administrator 6.
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A Cool Tool: When you wish to enter data in a number of fields on a form, use the TAB key to move from 

one field to the next.

When you wish to view a dropdown list, either click the dropdown arrow to the left of the 

  2. Enter Essential Data

Project Name: rename 

the new project as 

Suburbia Elementary 

School

Project Number: enter 

00-9875.

Project Status: select 

Construct ion.

Enter the following:

Job Telephone: 

(123) 456-7890

Job Fax: 

(123) 456-7891

Start Date: 

12/1/00

Finish Date:

6/1/01

Approximate Contract 

Value: 

4,000,000

Description:

2 Story Addition to

Suburbia Elementary

School

Project Address:

500 M ain Street

Santa M onica, CA

90025

Click Save.

Click OK.

The Project Status of Construction indicates construction has already begun.

The final OK appears on a confirmation dialog.

After you enter this data, the project appears in the Project  Control list within the 

Construct ion group.
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list:

or else click in the field and press F4.
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A.3 How Do I Enter Project Information?

In this task, you will add essential descriptive information for the new project you just created.

Portfolio M anager: 

select Suburbia 

Elementary School

Click the 

M iscellaneous tab

Type of Contract: 

GM P

Type of Construct ion: 

Steel Frame

Type of Building: 

School

Company ID: ACC

Enter names for the 

project leaders in the 

following fields:

Project Executive

Project M anager

Project Architect

Construct ion 

M anager

Superintendent

Field Engineer

Click Save

This project is operating under a Guaranteed M aximum Price contract.

After you enter School, it will appear as a choice in the Type of Building list.

ACC is the code which represents Acme Construction Inc. which is used throughout most 

of the examples in this book.

Once you create the company code, you can type ACC into any Company field in Prolog 

Manager and ACC will be replaced with Acme Construction Inc.

You can save the record after these steps and then go back to the form later to add more 

data.
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A.4 How Do I Enter Legal Information?

The Project Details tab records legal information for companies working on your project, such as the name 

of the person with authority to sign change orders and other legal documents.

Project  Control page. 

Portfolio M anager: 

click the Project 

Details tab

Company Name 

column, Owner row: 

North City School 

District

Signing Authority 

column, Owner row: 

Pete Petrie

Company Name 

column, Architect 

row: JOF Architects

Address Line 1:

9056 Samson

Address Line 2:

Los Angeles, CA 

92340

Signing Authority 

column, Architect  

row: 

Brockton Hamilton

Contract  Date

10/1/00

Contract  For:

School addit ion

Click Save

When you type 00 in a date field, it is automatically read as 2000.



Lesson 1:  Project Setup

 15

A.5 How Do I Enter Contact Information?

Contacts are individuals who are associated with your project. In the course of a project, you will enter 

identification information on individuals many times. By designating an individual as a contact for your 

project, you can enter that individual’s data into your forms more easily. You can select individuals who have 

already been entered into your database (as they have been contacts for other projects) as contacts for your 

current project.

A Cool Tool: When you want to select a particular entry from a long pick list, you can jump quickly to 

that entry: Click the column header for which you know the entry (for example, Name) and 

then type the first letter of the entry you are searching for. The first entry in the list 

beginning with that letter is selected. Type the second letter of the name you are searching 

for and the first entry in the list beginning with the two letters you typed is selected, and so 

on.

With Portfolio 

M anager still opened 

to Suburbia 

Elementary School, 

click the Contacts tab

Click Add Link

Select the following 

individuals:

Andrea Hamel

Andrew Forrest

Bill Jones

Click OK

Click Save

Click Close

If you wish to designate an individual as a contact who does not appear on the Contacts 

pick list, you just first open the Company Setup form for that individual’s company and 

enter the individual’s data on the Contacts tab of that form. For more information, see 

“How Do I Enter Company Contact Information?” on page 20.



Introduction to Prolog Manager 6

16

A.6 How Do I Log on to a New Project?

Now that you have created a new project, you will log on to it so that you can begin working in it.

In Prolog Manager, on 

the File menu, click 

Open Project

Select Suburbia 

Elementary School

Click OK
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B. Set t ing Up Ot her Companies on a Project
Other companies will work with your company on a project. Before you can create records which reference 

other companies on your job, you need to create a company record for each of the companies you work with 

in Prolog Manager. In order to enter this information, you must open a Prolog Manager 6 database and then 

enter the company information in the database, rather than the project. As a result, company information is 

available across all the projects within a single database.

B.1 How Do I Setup General Project Information?

In this task, you will create a company record for Lorring Steel, a subcontractor on the Suburbia Elementary 

School project.

On the Switchboard, 

click Admin, and on 

the shortcut menu, 

click Company Setup

Code: LOS

Name: 

Lorring Steel

Short Name:

LOS - 05120

Type of Company: 

Subcontractor

M ain Construct ion 

Division: 

Structural Steel (05)

Trade: 

M etal Decking, 

Structural Steel

Specification Section: 

05120

Click Save

LOS stands for Lorring Steel. The company code you are creating uses the first two letters 

of the first word of the company name, and the first letter of the second word of the name.

LOS - 05120 is our vendor number for Lorring Steel.
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B.2 How Do I Enter Address Information?

Once you create the record for Lorring Steel, you can enter address information for the company on the 

Addresses tab.

On the Company 

Setup form, click the 

Addresses tab

Click Add Row

Location:

M ain Office

Address 1 column: 

556 Bell Street

Address 2 column: 

Suite 161

City column: 

Oakland

State column: 

CA

Zip column: 

97071

Type of Address 

column: General

Click Save

When you save the record a Display Address is created, combining the information you 

entered into the Address 1, Address 2, City, State, and Zip columns.
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B.3 How Do I Add an Addit ional Company Address?

You also need to enter the information for the Lorring Steel jobsite office. 

Click Add Row

Location: 

Jobsite Trailer

Address 1:

123 Fifth Street

City: 

Santa M onica

State: 

CA

Zip: 

90025

Click: Save.
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B.4 How Do I Enter Company Contact Information?

You can use the Contacts tab to enter information for each of the contacts at a particular company. In this 

task, you will enter information for Don Walker, a contact at the main office of Lewis Steel.

  1. Personal Identification

On the Company 

Setup form, click the 

Contacts tab

Click Add Row

Init ials column: 

DW

Prefix column: M r.

First Name: 

Don

Last Name: 

Walker

Tit le column: 

Project M anager

Location column:

M ain Office

When you save the record (step 7 on the next page), a code is created and entered in the 
Contact ID field and the name Don Walker will appear in the Display Name column. 
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A Cool Tool: You can change the appearance of any grid in Prolog Manager. The following list describes 

the different changes you can make. (If you cannot make one of these changes, your 

computer or your company system is set up to not allow this feature. Consult your system 

administrator to discuss possible change.) 

  2. Additional Information

Check the Notify 

column

Linked Projects 

column, click Ellipsis 

(...) button

Project Number 

column: 00-9875

Click Copy selection

Click OK

On the far right-hand 

side of the grid, make 

sure Active is checked

Click Save.

By checking the Notify column, Don will receive automatic notification of events 
in Prolog WebSite via email

To do this: Here’s what to do:

To resize column width Click on the line separating two 

column titles and drag. 

To move columns Click on a column title and drag it.

To change the column order Click on the column header and select 

the field you want for that column 

from the list.
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To change the row height Click on the bottom line of the row on 

the gray box at the row’s extreme left 

and drag to the desired height.

To use the splitter The splitter appears as a double 

vertical line at the far left of the grid. 

When you scroll across a row to view 

other columns, the columns to the left 

of the splitter remain stationary. To use 

the splitter for the first time, right-click 

on the grid and click Grid Propert ies; 

then check Show Split ter. To change 

the number of stationary columns, 

click on the double line and drag it to 

the right of the columns you wish to 

remain stationary. 

For more on the splitter, see “How Do 

I Customize the Meeting Items Grid?” 

on page 299.

Change the number of columns to 

the left of the splitter

Click on the splitter (the double line) 

and drag it.

To do this: Here’s what to do:
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B.5 How Do I Enter Company Insurance Information?

On the Insurance tab, you can enter insurance policy information for Lewis Steel.

On the Company 

Setup form, click the 

Insurance tab

Click Add Row

Policy Name column: 

Gen. Liability

Policy Number 

column: 

123-456-7890

Received Date 

column, type today’s 

date

Start Date column: 

type the first of this 

month

Expire Date column, 

enter the date one year 

from today

Scroll to the right and 

enter the following:

Amount  column, type:

1,000,000

Carrier column: 

Allied Insurance

Contact  column: 

Judy Jones.

Alert  column: check

Click Save.

Click Close.
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A Cool Tool: Note shortcuts to enter a date in a date field. You can use them in any date field in 

Prolog Manager:

1. CTRL + D enters today’s date

2. 1 + TAB enters the first of the current month; (any number + TAB enters that 

date of the current month)

3. Double-clicking the date field displays a calendar from which you can select 

any date.

You enter today’s date in the Received Date field, as the Certificate of Insurance was 

received today.

When you enter 1,000,000, the number converts to 1,000,000.00 when you move to the 

next cell in the grid.

The check in the Alerts box indicates that the policy is included in the Auto Alert 
notices.

Now that you have set up Lorring Steel as a company, you can refer to Lorring Steel in 

Prolog Manager forms and documents without having to re-type the company information.

You can enter additional information about a company on the Advanced Company Setup 

form. To view this form, on the Switchboard, click Admin and on the menu, click 

Advanced Company Setup. The information you can enter on this form is particularly 

useful for purchasing. (It is similar to the Vendor Profile form that was found in Prolog 

Manager 5)
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C. Import ing Dat a f rom Ot her Sources
In order to save data entry time, you can import data from other Prolog Manager projects within your current 

database or from other Prolog Manager databases by using the Import Common Prolog M anager data 

feature. You can also import information from a project schedule, spreadsheets, or word processing 

documents.

C.1 How Do I Import Tasks from a Schedule?

In this task, you’ll import schedule items from an outside schedule into your Prolog Manager project. By 

doing so, you can link records you create in Prolog Manager, such as buyout and submittal items and potential 

change orders, to project tasks which need to be completed, such as submittal packages, inventory deliveries, 

and inspections.

On the Prolog 

Manager Schedule 

menu, click Import 

Tasks

Click Browse

Files of type: select 

M PP Files (* .mpp)

Select the file 

C:\Program 

Files\M eridian\Prolog 

6\Program\Sample\

Sample.mpp

Click Open

Click OK 

Click Yes to confirm

A message asks, Automatically replace records with unique IDs? If you replace records 

which have unique IDs, you eliminate duplicating records in your database.
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D. Set t ing Up Cost  Periods
A cost period is an interval of time used to track costs. In Prolog Manager, you can determine the date range 

and length of cost periods. Cost periods are required if you are using Prolog Manager to track General 

Invoices, Contract Invoices and Applications for Payment .

D.1 How Do I Establish Cost Periods?

In this task, you will set up cost periods for the Suburban Elementary School.

On the Switchboard, 

click Admin and on the 

shortcut menu click 

Cost Periods

Click Add Row

From column: 

10/1/00

To column: 

10/31/00

Click Add Row

Click OK

To confirm, click Yes

When you click Add Row  the second time (step 5), a second period is created based on the 

information you entered in the first period.

Before closing the Cost Periods dialog, make sure that the current period is selected in the 

Current column.

When you click Yes to confirm your changes (step 7), you must wait a few moments while 

recalculations are made.
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L e s s o n  2

Security M anager

Overview

In this lesson, you will log on to a project, add a new contact for a 

company and then set up the contact in Security M anager. 

It contains:

SECURITY M ANAGER

A. Setting Up Security for Prolog Manager Users
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A. Set t ing Up Securit y for Prolog M anager Users
For your staff to log on to Prolog Manager, you must set them up as users in Security M anager. In this task, 

you will add yourself as a contact for the general contractor and then add yourself as a user in Security 

M anager.

A.1 How Do I Open a Project?

In the previous lesson, you created a new project. However, for the remainder of the class, you will use a 

different project within the same database to complete tasks. To use Security M anager, you must log on to 

the Prolog Sample Database as the administrator and open the training project, called Downtown M edical 

Center.

   

On Prolog Manager’s 

File menu, click Open 

Database

Verify Connection 

Name displays Prolog 

Sample Database

User Name: 

select Admin

Click OK

Select  Project: 

select Downtown 

M edical Center

Click OK

If you are already logged on to a database (step 1), a message asks if you want to close your 

current database. Click Yes.

Prolog Manager 6.0 databases can contain more than one project. A computer can contain 

more than one database.

If Admin does not appear in the list, click Refresh:  and then select Admin. Leave 

the Password field blank.
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A.2 How Do I Add a Contact to our Company Setup?

In this task, you will use the Company Setup form to add yourself as a contact for Acme Construction, Ltd.

On the Switchboard, 

click Admin and on the 

shortcut menu, click 

Company Setup

Click the Lookup 

button 

Double-click on Acme 

Construct ion, Ltd.

Click the Contacts tab

Click Add Row

Add yourself as a 

contact for Acme 

Construction. Enter 

your title and select a 

location.

Click Save

Click Close

To open the Company Setup form you can also click Company Setup on the Prolog 

Manager toolbar. 

When you click Save (step 7) a message appears asking you to confirm your changes. Click 

Yes.
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A Cool Tool: In Prolog Manager, when you add new records or save changes in your work, a message 

box appears asking if you want to confirm your changes. To turn this function off, on the 

Tools menu, click Preferences and on the submenu, click Options. On the Options dialog, 

remove the checks from Confirm before saving new data and Confirm before saving 

changes.

From here onward, this book assumes you have turned this feature off.

A Cool Tool: Notice the navigational buttons on the lower left of the Company Setup form:

 

These buttons appear on many pages throughout Prolog Manager. Use these buttons to 

“scroll through” all of the instances of what appears on the form. In this case, you can scroll 

through all of the companies in your database. The left-hand button arrow takes you to the 

first company. The right-hand arrow button takes you to the last one. The middle two take 

you one forward and one backward. These buttons are referenced in the Appendix section 

“Form Buttons Toolbar” on page 355.
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A.3 How Do I Add a User Group to Security M anager?

In this task, you will use Security M anager to create a user group for Acme Construction. On the Users tab 

in Security M anager, each folder represents a user group.

On the Tools menu, 

click Security, and on 

the submenu click 

Security M anager

Click the Group tab

Click Add Group

Under Group, in the 

Name field, type: 

Acme Construction

In the Description 

field, type: Employees 

of Acme Construction

Click Save
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A.4 How Do I Add a User to Security M anager? 

Now that you have added yourself as a contact for Acme Construction and created a user group for Acme 

Construction, you will add yourself as a user in Security M anager.

A Cool Tool: If you are logged in as Admin, the remaining tabs on Security Manager allow you change 

permissions assigned to members of the selected user group, as follows:

On the User tab, select 

the Acme 

Construction folder

Click Add User

Select your name

Click OK

On the User tab in the 

Password field, leave 

the field blank

Check Access for each

Click Save

Click Close

You can assign the user a login password (step 5); however, you will not assign a password 

at this time.

You can select your own name because you previously added yourself as a contact.

Tab Allows you to:

Feature Permissions Make whole forms invisible to members of the 

selected user group

Data Group Permissions Make a group of data elements invisible or read-only 

for the members of the selected user group
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Record Set Permissions Assign permission to view, add, modify or delete 

specific record types. To keep your Company data 

consistent, you may want to eliminate permission to 

Add on Company Setup data on this tab for most users.

Project Permissions Specify individuals who can view any information for 

a specific project

Tab Allows you to:



Introduction to Prolog Manager 6

34

A.5 How Do I Log on to the Training Database as M yself?

In A.1 you logged on to the training database as the administrator. Now that you have set yourself up as a user 

in Security M anager, you can log on to the training database as yourself:

On the Prolog 

Manager File menu, 

click Close Database

On the File menu, click 

Open Database

User Name list, select 

your name

Click OK

Select Downtown 

M edical Center

Click OK


